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This presentation (the “Presentation”) has been prepared by Definium Therapeutics, Inc. (“Definium”, the “Company”, “we”, “our” or “us") solely for informational purposes. This Presentation does not constitute an offering of, or a solicitation of an offer to 
purchase, securities of Definium and under no circumstances is it to be construed as a prospectus or advertisement or public offering of securities. Any trademarks included herein are the property of the owners thereof and are used for reference purposes 
only. Such use should not be construed as an endorsement of the products or services of Definium. Any amounts are in USD unless otherwise noted. Definium’s securities have not been approved or disapproved by the U.S. Securities and Exchange 
Commission (the "SEC") or by any state, provincial or other securities regulatory authority, nor has the SEC or any state, provincial or other securities regulatory authority passed on the accuracy or adequacy of this Presentation. Any representation to the 
contrary is a criminal offense.

Cautionary Note Regarding Forward-Looking Statements
This Presentation contains, and our officers and representatives may from time to time make, “forward-looking statements” within the meaning of applicable securities laws and are prospective in nature. Forward-looking statements are not based on 
historical facts, but rather on current expectations and projections about future events and are therefore subject to risks and uncertainties which could cause actual results to differ materially from the future results expressed or implied by the forward-
looking statements. These statements generally can be identified by the use of forward-looking words such as “will”, “may", “should”, “could”, “intend”, “estimate”, “plan”, “anticipate”, “expect”, “believe”, “potential”, “continue”, “budget”, “scheduled”, 
“forecasts”, “intends”, “anticipates”, “projects” or the negative thereof or similar variations. Forward-looking statements in this Presentation include, but are not limited to, statements regarding the anticipated design, timing, progress and results of our 
investigational programs for DT120 oral disintegrating tablet (“ODT”), a proprietary, pharmaceutically optimized form of lysergide tartrate (including the anticipated topline readouts for the Voyage, Panorama, Emerge and Ascend studies), DT402, also 
referred to as R(-)-MDMA, and any other product candidates; our ability to identify new indications for our lead product candidates beyond our current primary focuses; the success and timing of our development activities; the success and timing of our 
planned clinical trials; our ability to meet the milestones set forth herein; the likelihood of success of any clinical trials or of obtaining U.S. Food and Drug Administration (“FDA”) or other regulatory approvals; our beliefs regarding potential benefits of our 
product candidates; opinions of potential providers, patients and payors regarding our product candidates, if approved and commercialized; statements regarding potential reimbursement and coding for DT120, if approved and commercialized; our ability 
to maximize operational efficiencies through our trial designs; strategies to address drug class methodological considerations; our cash runway funding operations into 2028 based on our current operating plan and anticipated milestones; our pre-launch 
strategy; the potential commercial opportunity for DT120 ODT, if approved, including total addressable market; the potential delivery model for DT120 ODT, if approved; the potential for the markets that we are anticipating to access; protection of our 
intellectual property; and the potential for psychedelics as a class of treatment options in psychiatry. 

There are numerous risks and uncertainties that could cause actual results, plans and objectives to differ materially from those expressed in forward-looking statements, including history of negative cash flows, limited operating history, incurrence of future 
losses, availability of additional capital, compliance with laws and regulations, difficulty associated with research and development, risks associated with clinical trials or studies, heightened regulatory scrutiny, early stage product development, clinical trial 
risks, regulatory approval processes, novelty of the psychedelic inspired medicines industry, our ability to maintain effective patent rights and other intellectual property protection for our product candidates, our expectations regarding the size of the 
eligible patient populations for our lead product candidates, if approved and commercialized; our ability to identify third-party treatment sites to conduct our trials and our ability to identify and train appropriate qualified healthcare practitioners to 
administer our treatments; the pricing, coverage and reimbursement of our lead product candidates, if approved and commercialized; the rate and degree of market acceptance and clinical utility of our lead product candidates, in particular, and controlled 
substances, in general; as well as those risk factors described in the Company's Annual Report on Form 10-K for the fiscal year ended December 31, 2025 under headings such as “Special Note Regarding Forward-Looking Statements,” and “Risk Factors” 
and “Management's Discussion and Analysis of Financial Condition and Results of Operations” and other filings and furnishings made by the Company with the securities regulatory authorities in all provinces and territories of Canada which are available 
under the Company's profile on SEDAR+ at www.sedarplus.ca and with the SEC on EDGAR at www.sec.gov.

Any forward-looking statement made by Definium in this Presentation is based only on information currently available to the Company and speaks only as of the date on which it is made. Except as required by law, the Company undertakes no duty or 
obligation to update any forward-looking statements contained in this Presentation as a result of new information, future events, changes in expectations or otherwise.

Cautionary Note Regarding Regulatory Matters
The United States federal government regulates drugs through the Controlled Substances Act. DT120 ODT is a proprietary, pharmaceutically optimized form of lysergide D-tartrate and DT402, or R(-)-MDMA, is our proprietary form of the R-enantiomer of 
MDMA (3,4-methylenedioxymethamphetamine). Lysergide and MDMA are Schedule I substances under the Controlled Substances Act. While the Company is focused on programs using psychedelic or hallucinogenic compounds and non-hallucinogenic 
derivatives of these compounds, including in DT120 ODT, DT402 and its other product candidates, the Company does not have any direct or indirect involvement with the illegal selling, production or distribution of any substances in the jurisdictions in 
which it operates. The Company is a neuro-pharmaceutical drug development company and does not deal with psychedelic or hallucinogenic substances except within laboratory and clinical trial settings conducted within approved regulatory frameworks. 
The Company's products will not be commercialized prior to applicable regulatory approval, which will only be granted if clinical evidence of safety and efficacy for the intended uses is successfully developed.

Market and Industry Data
This Presentation includes market and industry data that has been obtained from third party sources, including industry publications. Definium believes that the industry data is accurate and that the estimates and assumptions are reasonable, but there is 
no assurance as to the accuracy or completeness of this data. Third party sources generally state that the information contained therein has been obtained from sources believed to be reliable, but there is no assurance as to the accuracy or completeness 
of included information. Although the data is believed to be reliable, Definium has not independently verified any of the data from third party sources referred to in this Presentation or ascertained the underlying economic assumptions relied upon by such 
sources. References in this Presentation to research reports or to articles and publications should not be construed as depicting the complete findings of the entire referenced report or article. Definium does not make any representation as to the accuracy 
of such information. 
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Late-stage 
pipeline

DT120 ODT: lead 
clinical program 
in four Phase 3 

studies1

Experienced 
management team

Proven track record 
in developing and 

commercializing novel 
CNS therapies

3

Three Phase 3 readouts 
anticipated in 2026 driving 
potential billion-dollar 
commercial opportunities in 
GAD and MDD 

1. Includes three studies in progress and one in preparation.
2. Based on the Company’s current operating plan and anticipated milestones.

CNS: central nervous system; GAD: generalized anxiety disorder; MDD: major depressive disorder; ODT: orally disintegrating tablet

Strategic focus 
on GAD & MDD

The two largest 
drivers of psychiatric 

disease burden

Comprehensive 
intellectual 

property strategy
DT120 ODT patents issued 
covering pharmaceutical 
formulation, methods of 

manufacturing and 
treatment

Strong financial position 
Cash, cash equivalents and 

investments of $411.6 million 
as of December 31, 2025; 
cash runway expected to 

extend into 20282

Corporate Presentation | February 2026
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Confidential – For internal use only 4

Anxiety & Depressive Disorders Represent a 
Massive and Growing Unmet Need

56%3

GAD & MDD Prevalence

>50 million1

GAD & MDD Annual Growth Rate

5%+2

Psychiatry Needs Better

1. Ringeisen, H., et al. (2023). Mental and Substance Use Disorders Prevalence Study (MDPS): Findings Report,  Zhou, Y,. 
Et al. (2017). Nature. Comorbid generalized anxiety disorder and its association with quality of life in patients with major 
depressive disorder. RTI International and current U.S. Census data and internal company estimates.

2. Terlizzi EP and Zablotsky B (2024). Symptoms of Anxiety and Depression Among Adults, calculations on file.
3. Data on file. Louie D, et al. Treatment Patterns for Newly Diagnosed Generalized Anxiety Disorder (GAD): Insights from 

Real-World Evidence. Presentation at ACNP 2026.

Outdated Frameworks

▪ Language and labels reflect symptom 
management not recovery

Recycled Mechanisms

▪ New drugs, similar efficacy

▪ Limited differentiation over decades

Outcomes Lag Behind Need

▪ Large and persistent unmet demand

▪ Escalating societal and human cost

Psychiatry is Limited by 
Today’s Treatment Options

Average Time to Rx discontinuation in GAD 

<90 days3



Design tips: 
▪ Turn the grid (under ‘View’ tab) on to algin content easily.
▪ To toggle between body master text styles, use the indent button located on the Home tab (next to the number bullet button)
▪ Change the color of the background  using the ‘Format Background’  tool located under the Design tab (choose from Lavender, White or Light Gray)

5

Advancing Our Pipeline with Broad Therapeutic Potential 

PRODUCT CANDIDATE INDICATION PRECLINICAL PHASE 1 PHASE 2 PIVOTAL / PHASE 3 REGISTRATION

Lysergide tartrate
DT1201 

Generalized Anxiety
Disorder (GAD)3

Major Depressive 
Disorder (MDD)3

Additional
Indication(s)4

R(-)-MDMA
DT4022

Autism Spectrum
Disorder (ASD)3

1. Formerly known as MM120; rINN: lysergide tartrate.
2. Formerly known as MM402.
3. Full trial details and clinicaltrials.gov links available at definiumtx.com/clinical-digital-trials/ 
4. Studies in exploration and/or planning stage.

ODT: orally disintegrating tablet; R(-)-MDMA: rectus-3,4-methylenedioxymethamphetamine Corporate Presentation | February 2026



Program Overview

Lysergide 
tartrate 
DT120
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DT120 Phase 2b Efficacy and Durability Demonstrates 
Potential Best-In-Class Profile1,3

Standardized effect size more than double the standard of care
1,2,3

Comparative Effect Sizes in GAD Rapid and durable response after single administration3

Rapid

Response 
& Remission  

Durable

Standalone Drug 
Effect 

Limited Adverse 
Event (AE) Burden

1.8-point reduction in CGI-S within 24 
hours (p<0.0001)

21.9-point improvement on the HAM-A 
at Week 12 (p=0.003)

48% of participants in remission at 
Week 125

Favorable tolerability with most AEs on 
dosing day

Observed drug effect without 
accompanying psychotherapy

0 0.2 0.4 0.6 0.8

Cohen’s d

SRIs4

Benzodiazepines4

Buspirone4

DT120 100 µg2 0.81

0.38

0.36

0.17

1. Study MMED008 internal study documents and calculations. Comparisons to standard of care/other drug classes based on historical comparison not head-to-head comparison trial. 
2. HAM-A scores based on ANCOVA LS Mean. in Study MMED008. Effect size based on post hoc calculation using LS Mean change between group and pooled standard deviation of week 12 HAM-A scores between groups. 
3. Based on 100 µg dose group.
4. RB Hidalgo, J Psychopharmacol. 2007 Nov;21(8):864-72.
5.  p-values not calculated for remission rates between groups.

CGI-S: Clinical Global Impression – Severity scale; GAD: generalized anxiety disorder; HAM-A: Hamilton Anxiety scale; SRI: serotonin reuptake inhibitor
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DT120’s Clinical Activity Stands Out Compared to 
Approved GAD Treatments1

1) The information presented in this slide is derived from multiple clinical trials, each conducted under distinct protocols and settings. As such, these data may not be directly comparable due to the lack of a head-to-head comparison. 
Differences in trial design, patient demographics, and other variables may account for variations in the observed outcomes. Study results for each drug are intended to be representative, however, multiple trials of the approved treatments 
have been conducted with varying results, including results that may have demonstrated a larger or smaller treatment effect than those presented. BuSpar and Xanax are approved for anxiety disorders which include GAD.; 2) R Robison, 
JAMA. 2025 Sep 4; e2513481. doi:10.1001/jama.2025.13481; 3)  C Allgulander, Curr Med Res Opin. 2007;23(6):1245–1252; 4) JRT Davidson, Depress Anxiety. 2004;19(4):234–240; 5) K Rickels K, Am J Psychiatry 2003; 160:749-756. 
2005;62(9):1022–1030; 6) AJ Gelenberg AJ, JAMA. 2000;283(23):3082–3088; 7) JJ Sramek JJ, Journal of Clinical Psychiatry. 1996;57(7):287–291; 8) K Rickels, Arch Gen Psychiatry. 2005;62(9):1022–1030.

GAD: generalized anxiety disorder, Tx: treatment
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DT120
Single Dose
 (12 weeks)

Duloxetine
Chronic (9-10 weeks)

Escitalopram
Chronic (8 weeks)

Paroxetine
Chronic (8 weeks)

Venlafaxine XR
Chronic (28 weeks)

Buspirone
Chronic (8 weeks)

Alprazolam
Chronic (4 weeks)
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HAM-A Change Tx HAM-A Change Placebo Placebo-Adjusted Change
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Primary Outcome: HAM-A Change from Baseline

1. Source: Study MMED008 internal study documents and calculations. Full analysis set population.
2. Based on 100 µg dose group. 
3. Based on observed MADRS score at each timepoint.
4. Primary endpoint of the study was change in Hamilton Anxiety Scale (HAM-A) at week 4 using the MCP-Mod statistical analysis.  Based on the pre-specified candidate dose response curves, the MCP-Mod model-estimated difference between 

100 µg and placebo was 5.0 points versus the observed difference of 7.6 points at week 4.

μg: microgram; HAM-A: Hamilton Anxiety Rating Scale; MADRS: Montgomery-Åsberg Depression Rating Scale NOTE: Significance achieved despite study not being powered for these pairwise comparisons.

DT120 Showed Statistically & Clinically Significant 
Improvements on Anxiety and Depression Symptoms1,2

*p<0.05; **p≤0.01; ***p≤0.001

*** ***
***

**

MADRS Change from Baseline
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** ** * **

Change from Baseline2

▪ Week 12: -21.9 points

Improvement over Placebo2

▪ Week 12: -7.7 pts, p=0.003

Change from Baseline2,3

▪ Week 12: -18.7 points

Improvement over Placebo2,3

▪ Week 12: -6.4 points, p<0.01

9

Placebo 100 µg 
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Remission (≤7)
Symptoms are absent, insignificant, or clearly due to 
causes other than anxiety

Mild (8-14)
Symptoms are infrequent, with no impairment and 
no more than mild distress

Moderate (15-23)
Symptoms are more frequent, with moderate 
distress or limited interference with usual activities

Very Severe
Symptoms are incapacitating

Severe (≥24)
Symptoms are severe and persistent or result in 
severe distress or marked impairment in functioning

DT120 Demonstrated Profound Changes in GAD Severity1

1. Source: Study MMED008 internal study documents and calculations. Full analysis set population.
2. Response is a 50% or greater improvement on HAM-A score; Remission is a HAM-A score of ≤7; p-values not calculated.

μg: microgram; HAM-A: Hamilton Anxiety Rating Scale

HAM-A Response & Remission at Week 122Median HAM-A Through Week 12HAM-A Severity & Clinical Symptoms

31%

21%

65%

48%

% Responders % Remitters

Percent of Participants Meeting Criteria at Week 12

Placebo 100 µg
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Scientific Rigor in DT120 Phase 2b Provides 
Confidence for Phase 3 Program

11

▪ Statistically significant dose response in 
Phase 2b

▪ Model supports 100 µg as optimal dose

▪ Results not explainable by “functional 
unblinding” supporting robustness of drug 
effect

1. Study MMED008 internal study documents and calculations.
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Model-Based Dose-Response Curve1Key Findings
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DT120 was Well-Tolerated with Adverse Events 
Mostly Limited to Dosing Day1

1. Source: Study MMED008 internal study documents and calculations. Safety population.
2. One serious adverse event (SAE) was observed in the 50 µg dose group: panic attack on study day 98 that was deemed not related to treatment.
3. Suicidality assessment based on reported adverse events.

▪ Virtually all (99%) adverse events (AEs) were mild-to-moderate in severity
▪ Minimal (2.5%) treatment emergent AEs (TEAEs) led to study withdrawal
▪ No drug-related serious AEs (SAEs)2

Favorable 
tolerability profile

No SAEs related to 
study drug

No suicidal 
behavior or 

suicidality signal3

▪ Only SAE was in 50 µg dose group and deemed unrelated2

▪ AE profile consistent with historical studies and drug class

▪ No suicidal or self-injurious behavior
▪ No indication of increased suicidality or suicide-related risk
▪ ≤2 participants per arm reported suicidal ideation during the study

12Corporate Presentation | February 2026
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Rigorous Development Approach Addresses Key 
Regulatory Considerations

Corporate Presentation | February 2026

Complementary clinical study designs intended to generate robust evidence

▪ Phase 2b and 3 studies intended to address key regulatory considerations for psychedelics

▪ 50 µg control dose in Panorama and Ascend intended to further mitigate effects of functional unblinding

▪ Central raters blinded to treatment allocation and visit number to minimize bias

 

First study in the field to evaluate dose-dependent efficacy 

▪ Phase 2b study established dose-response across four doses of DT120: 25, 50, 100 and 200 µg

▪ 100 µg selected as optimal dose for Phase 3 program

Phase 3 program builds on Phase 2b success with optimized study designs

▪ Placebo response expected to moderate with 1:1 randomization in Phase 3 studies

▪ Offers open-label treatment opportunities which are intended to improve participant retention

▪ Potentially provides information on real world treatment patterns

13
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Robust Phase 3 DT120 ODT Development Program Aiming 
for Broad Label

1. Studies employ an adaptive design with interim blinded sample size re-estimation (“SSRE”) based on nuisance parameters (e.g. patient retention rate, variability of primary outcome measure) which allows for an adjustment of the sample size of up to 
50% to maintain statistical power.

2. Clinical study designs subject to ongoing regulatory discussion and review, including of Phase 3 clinical trial protocols.
3. Reflects actual enrollment for the Emerge study.
4. Power analysis based on additional assumptions including variance and subject evaluability; realized study power may differ from a priori power estimation.

DB: double blind; HAM-A: Hamilton Anxiety Rating Scale; MADRS: Montgomery-Åsberg Depression Rating Scale; ODT: orally disintegrating tablet; OL: open-label; RCT: randomized controlled trial

Generalized Anxiety Disorder (GAD) Major Depressive Disorder (MDD)

n=2001,2

1:1 randomization

DT120 ODT 
vs. Placebo

▪ Part A: 12-week DB, RCT
▪ Part B: 40-week Extension 

with OL Treatment

n=2501,2

2:1:2 randomization

DT120 ODT 
vs. Placebo

including 50 µg control

▪ Part A: 12-week DB, RCT
▪ Part B: 40-week Extension 

with OL Treatment

n=1493

1:1 randomization

DT120 ODT 
vs. Placebo

▪ Part A: 12-week DB, RCT
▪ Part B: 40-week Extension 

with OL Treatment

n=1752

2:1:2 randomization

DT120 ODT 
vs. Placebo

including 50 µg control

▪ Part A: 12-week DB, RCT
▪ Part B: 40-week Extension 

with OL Treatment

14

Aligned clinical trial designs across indications maximize operational efficiencies

Anticipated Topline Readout – early 3Q 2026
SSRE complete; no change to sample size

Anticipated Topline Readout – 2H 2026 Anticipated Topline Readout – late 2Q 2026 Planned Initiation – early 2Q 2026

Primary Endpoint HAM-A at Week 12
90% powered to detect a 5-point difference4

Primary Endpoint MADRS at Week 6
80% powered to detect a 5-point difference4

Corporate Presentation | February 2026



Design tips: 
▪ Turn the grid (under ‘View’ tab) on to algin content easily.
▪ To toggle between body master text styles, use the indent button located on the home tab (next to the no. bullet button)

Design tips: 
▪ Turn the grid (under ‘View’ tab) on to algin content easily.
▪ To toggle between body master text styles, use the indent button located on the home tab (next to the no. bullet button)

Two Complementary Pivotal GAD Study Designs

1. Studies employ an adaptive design with interim blinded sample size re-estimation (“SSRE”) based on nuisance parameters (e.g. patient retention rate, variability of primary outcome measure) which allows for an adjustment of the sample size 
of up to 50% to maintain statistical power. SSRE for Voyage is complete and no change to the sample size is required. Clinical study designs subject to ongoing regulatory discussion and review, including of Phase 3 clinical trial protocols.

GAD: generalized anxiety disorder; GAD-7: diagnostic tool used to screen for and assess the severity of generalized anxiety disorder; HAM-A: Hamilton Anxiety Rating Scale; ODT: orally disintegrating tablet

DT120 ODT 100 µg n=100

Placebon=100

Part A
12 Week Randomized, Double-Blind

Part B
40 Week Extension with Opportunity for Open-Label Treatment 

DT120 ODT 100 µg n=100

Placebon=100

n=50

PHASE 3 STUDY1

Single Dose

Primary Endpoint HAM-A at Week 12

Up to four open-label doses of DT120 ODT 100 µg 

Single Dose

Follow-up Observation
GAD-7 (ePRO): biweekly

HAM-A (central rater): monthly or when GAD-7≥10 

Potential Treatment
Eligible for open-label treatment if HAM-A≥16

DT120 ODT 50 µg 
control 

15Corporate Presentation | February 2026
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Two Complementary Pivotal MDD Study Designs

1. Clinical study designs subject to ongoing regulatory discussion and review, including of Phase 3 clinical trial protocols.

MADRS: Montgomery-Åsberg Depression Rating Scale; MDD: Major Depressive Disorder; ODT: orally disintegrating tablet; PHQ-9: a multipurpose instrument for screening, diagnosing, monitoring and measuring the severity of depression

DT120 ODT 100 µg n=70

Placebon=70

Part A
12 Week Randomized, Double-Blind

Part B
40 Week Extension with Opportunity for Open-Label Treatment 

DT120 ODT 100 µg n=70

Placebon=70

n=35

PHASE 3 STUDY1

Single Dose

Primary Endpoint MADRS at Week 6

Up to four open-label doses of DT120 ODT 100 µg 

Single Dose

Follow-up Observation
PHQ-9 (ePRO): biweekly

MADRS (central rater): monthly or when PHQ-9≥10 

Potential Treatment
Eligible for open-label treatment if MADRS≥20

DT120 ODT 50 µg 
control 
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Regulatory Elements Support DT120 ODT NDA Strategy

1. Study MMED008 internal study documents and calculations. Comparisons to standard of care/other drug classes based on historical comparison not head-to-head comparison trial.

GAD: generalized anxiety disorder; NDA: new drug application; ODT: orally disintegrating tablet

Studies 
designed to 

demonstrate 
standalone 
drug effect

FDA 
Breakthrough 

Therapy 
Designation

Phase 2b 
demonstrated 

substantial 
improvement 
over current 

therapies1

Phase 3 
program in 

alignment with 
FDA guidance

Phase 3 
study designs 

mirror positive 
Phase 2b study
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Commercial Framework

Lysergide 
tartrate 
DT120 ODT
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Large, Identified, Accessible Opportunity for DT120 ODT

1. Bandelow B et al. World J Biol Psychiatry. 2008;9(4):248-312. 2. Ansara ED. Ment Health Clin. 2020;10(6):326-334. 3. Fagan HA, Baldwin DS. Expert Rev Neurother. 2023;23(6):535-548. 4. Garakani A et al. Front Psychiatry. 2020;11:595584. 5. 
Keyloun KR et al. CNS Drugs. 2017;31(5):421-432. 6. Cascade E et al. Psychiatry (Edgemont). 2009;6(2):16-18. 7. National Institute for Health and Care Excellence. Anxiety disorders. Quality standard QS53. February 6, 2016. Accessed July 10, 2025. 
https://www.nice.org.uk/guidance/qs53, 8. Bull SA et al. Ann Pharmacother. 2002;36:578-584. 9. Berger A et al. BMC Psychiatry. 2011;11:193. 10. Jacobsen PL et al. American Psychiatric Association Annual Meeting. May 4-8, 2024. New York, NY; 11. 
Based on internal company estimates.

 
GAD: generalized anxiety disorder; HCP: healthcare provider; MDD: major depressive disorder; ODT: orally disintegrating tablet; Rx: prescription; SSRI: selective serotonin-reuptake inhibitor
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High Unmet Need
Potential Paradigm 

Shifting Clinical Profile
Efficient Go To Market 

Strategy

Significant Limitations of 
Existing Treatments

Potential
Best-In-Class Therapy

Existing Referral Network and 
Administration Sites of Care

Sustained clinical response 
from a single administration10

Identifiable HCPs 
and patients suffering from the 
burden of inadequate treatment

Poor efficacy, 
tolerability, and 
persistence

~50% Discontinue SRIs in 
first 4 mos. in GAD8,9

Rapid onset of effect

High response rates

High remission rates

Durable response

Intermittent dosing potentially 
reduces the risk of adverse long-
term effects    

• Slow onset of effect1

• Low response and 
remission rates2-4

• Low Rx persistence5

• Weight gain6

• Sexual dysfunction6

• Tolerance and 
dependence7

Poor 
Tolerability

Poor 
Efficacy ~7,000 

Psychiatry HCPs see >50% of likely 
DT120 ODT patients11

~22% Rx persistence at 
12 mos. in MDD5

Based on claims data

Anticipate scalable delivery 
model in diverse care settings

Positive practice economics 
anticipated to expand sites of care 

Corporate Presentation | February 2026
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▪ Clinical dosing period is 8 hours for study participants; readiness to leave is evaluated from hours 5-8.
▪ Patients are supported by DSMs, healthcare professionals who passively observe and offer comfort care such as 

assistance with food or restroom breaks.
▪ Psychotherapy is not offered in our studies or expected to be required, if approved. 
▪ Real world support will be based on decisions between providers and patients to support individual goals and needs.

Ordinary 
perception, 
affect, and 
cognition return

Normal activities 
resume the next 
day, including 
driving 

Transient perceptual, affective, and 
cognitive drug effects vary from 
person to person

Hours 2-3: effects reach maximum 
intensity

Hours 4-6: effects start to resolve 

DT120 ODT 
disintegrates in 
seconds

Hour 5: Dosing Session 
Monitor (DSM) evaluates 
patient hourly with an 
end-of-session checklist 
to determine when the 
patient can leave safely

5 to 8 hour duration 
offers an extended 
window for emotional 
processing and a gentle, 
predictable return to 
baseline

Efficient single-visit model with full-session reimbursement streamlines administrative burden2 

Corporate Presentation | February 2026

DT120 ODT Clinical Dosing Paradigm with Potential 
Translatability to Efficient Real-World Delivery1,2 

1. Dosing and monitoring paradigm based on Phase 3 clinical protocols.
2. Existing coding systems could potentially be applied or be changed for DT120. Reimbursement and coding for DT120 have yet to be established.

ODT: orally disintegrating tablet

Hour 6+ and 
post-session

Hour 1-615-30 minutes 
(time to onset)

Hour 5-8

20
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75%
believe there is a significant unmet 

need in GAD1

Healthcare Professionals

Psychiatry is Primed for Strong Adoption of DT120 ODT

1. Market research on file.

GAD: generalized anxiety disorder; HCP: healthcare professional; ODT: orally disintegrating tablet ; TPP: target product profile

Motivated to prescribe

70%
of surveyed HCPs intend to 
prescribe or recommend 

DT120 ODT for GAD1

Patients

Eager for effective treatments

50%
are dissatisfied with current GAD 

treatments1

65%
with multiple GAD treatment 

failures interested in trying 
DT120 ODT1 

Payors

Optimistic product reception 
& access roadmap

Had an overall                         

positive reaction                
to the DT120 ODT TPP1

Benchmark DT120 ODT 
against other current 

interventional therapies for 
access and pricing1

JPM Conference Presentation | January 2026 21

Corporate Presentation | February 2026



Design tips:
▪ Turn the grid (under ‘View’ tab) on to algin content easily.
▪ To toggle between body master text styles, use the indent button located on the Home tab (next to the number bullet button)
▪ Change the color of the background  using the ‘Format Background’  tool located under the Design tab (choose from Lavender, White or Light Gray)

22

Positioned to Leverage Existing Delivery Infrastructure, 
Practice Patterns & Reimbursement Pathways

Office-based or 

Telehealth 

Prescriber1

Evaluation & 

Prescribing

PharmacyDT120 ODT

Site of delivery

Session Delivery

Activity 

Medical Benefit

CPT-I E&M Code (992XX)

Pharmacy Benefit

J Code & Dispensing Fee

Medical Benefit

CPT-III Code4 (0820T/0821T/0822T)

or 

CPT-I Service Codes

(992XX + 994XX)

Stakeholder Potential Reimbursement/Coding3

HCP2 to monitor 

session

Corporate Presentation | February 2026

1. HCP that is licensed to prescribe medications to patients.
2. HCP that is licensed to practice, which may include physicians, clinical psychologists, nurse practitioners, nurses, licensed clinical social workers, licensed family and marriage therapists and others.
3. Existing coding systems could potentially be applied or be changed for DT120. Reimbursement and coding for DT120 have yet to be established.
4. The currently available CPT-III codes (0820T, 0821T, 0822T) describe the in-person continuous monitoring of a psychedelic medication therapy session.

CPT: Current Procedural Terminology; HCP: healthcare professional; ODT: orally disintegrating tablet
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Framing the Compelling Opportunity for DT120 ODT
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$7.0 

$4.9

$2.8 

 $-  $1.0  $2.0  $3.0  $4.0  $5.0  $6.0  $7.0  $8.0

Potential Revenue in Billions

Potential Annual Revenue Opportunity

per 100,000 patients

Opportunity Drivers

1. Calculations on file; Ringeisen, H., et al. (2023). Mental and Substance Use Disorders Prevalence Study (MDPS): Findings Report. RTI International and current U.S. Census data and internal company estimates.
2. Range is based on Spravato surrogate low dose, low frequency ($28k) to high dose, high frequency ($70k) annually. Market Research, Data on file, 2025

GAD: generalized anxiety disorder; MDD: major depressive disorder; ODT: orally disintegrating tablet

US adults receiving medication for
GAD or MDD~27.0 million1

Market penetration to treat 
100,000 patients0.4%

Estimated annual pricing 
(analogous range)$28k to $70k2

B

B

B

At $28k annual price

At $49k annual price

At $70k annual price
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▪ San Francisco metro area is approximately 1.4% of the US population with 49 top HCPs at 44 clinics 
that could potentially prescribe DT120 ODT

San Francisco Metro Contribution (per 100k nationwide) 

44
top target 
psychiatric 

clinics2

32
average 

patients treated 
per clinic

1,400
patients treated 

in SF metro

2-3
average patients 

treated per month 
per clinic

Key San Francisco Metro Market Metrics1

✓ Total adult population: 3.8 million

✓ Population as a % of total US: 1.4%

✓ Top Target2 HCPs: 49

✓ Top Target2 Clinics: 44

1. Data Calculations from Claims analysis for San Francisco MSA; 2025
2. Top targets include healthcare professionals (HCPs) in deciles 7-10 based on market research.

ODT: orally disintegrating tablet

A Regional Example: San Francisco
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Program Update

R(-)-MDMA
DT402
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DT402 Phase 2a Study in Autism Spectrum Disorder (ASD)

26

1. Shaw KA, Williams S, Patrick ME, et al. Prevalence and Early Identification of Autism Spectrum Disorder Among Children Aged 4 and 8 Years — Autism and Developmental Disabilities Monitoring Network, 16 Sites, United States, 2022. MMWR 
Surveill Summ 2025;74(No. SS-2):1–22. DOI: http://dx.doi.org/10.15585/mmwr.ss7402a1

SAE: serious adverse event; TEAE: treatment-emergent adverse event

Completed Phase 1 study in 2024
▪ Single-ascending dose study in healthy adult volunteers characterized the tolerability, pharmacokinetics 

and pharmacodynamics of DT402
▪ DT402 was well-tolerated at doses up to 255 mg with no SAEs or TEAEs leading to discontinuation, 

supporting advancement into Phase 2 clinical trials
 
Phase 2a study underway

▪ Single-dose, open-label study to assess early signals of efficacy of DT402 in treating core social and 
communication symptoms of ASD in up to 20 adult participants

▪ Study endpoints designed to characterize pharmacodynamics and clinical effects of DT402 in adults with 
ASD, including on multiple functional biomarkers

▪ Initial data anticipated in 2026

About ASD

▪ ASD is a neurodevelopmental condition characterized by persistent challenges with social communication, 
restricted interests and repetitive behavior

▪ US prevalence of approximately 1 in 31 children1 with no approved pharmacotherapies for the treatment of 
core symptoms of ASD
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Value Creation Opportunity Shaped by Two Distinct Drivers1 

1. Timing estimates subject to clinical progress and regulatory interactions.

ASD: autism spectrum disorder; GAD: generalized anxiety disorder; TLR: topline data readout

Clinical & Regulatory Execution

2026 2027 2028

Commercial Execution

Value Creation

Expanding Site of Care 
Engagement & 

Commercial Footprint

Accelerating 
Scheduling & 

Reimbursement

Optimizing Patient 
Care Model 

Emerge TLR

Voyage TLR Initial DT402 Data    
in ASD

Panorama TLR Potential Pipeline 
Expansion

Ascend TLR

Potential First GAD
Commercial Launch since 2007
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Financial Summary & 
Anticipated Milestones

1. Excludes 9.4 million pre-funded warrants outstanding as of December 31, 2025

ASD: autism spectrum disorder; GAD: generalized anxiety disorder; G&A: general & administrative; MDD: major depressive 
disorder; R&D: research and development

Cash, Cash Equivalents & Investments
$411.6 million
as of December 31, 2025

Credit Facility
Up to $120 million 
($41 million outstanding)
as of December 31, 2025

Shares Outstanding
98.8 million1

as of December 31, 2025

Full Year 2025 Operating Expenses
$166.3 million
▪ R&D - $117.7 million
▪ G&A - $48.6 million

Topline Data Readouts

           Emerge (MDD)

          Topline Readout | late 2Q 2026

           Voyage (GAD)

          Topline Readout | early 3Q 2026

            Panorama (GAD)

           Topline Readout | 2H 2026

Additional Clinical Updates

            Ascend (MDD)

           Study Initiation | early 2Q 2026

            DT402

           Initial Data in ASD | 2026
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We look forward to hosting an Investor & Analyst Day on April 22, 2026 in New York City
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